ghipsmall

Chipsmall Limited consists of a professional team with an average of over 10 year of expertise in the distribution
of electronic components. Based in Hongkong, we have already established firm and mutual-benefit business
relationships with customers from,Europe,America and south Asia,supplying obsolete and hard-to-find components
to meet their specific needs.

With the principle of “Quality Parts,Customers Priority,Honest Operation,and Considerate Service”,our business
mainly focus on the distribution of electronic components. Line cards we deal with include
Microchip,ALPS,ROHM, Xilinx,Pulse,ON,Everlight and Freescale. Main products comprise
IC,Modules,Potentiometer,IC Socket,Relay,Connector.Our parts cover such applications as commercial,industrial,
and automotives areas.

We are looking forward to setting up business relationship with you and hope to provide you with the best service
and solution. Let us make a better world for our industry!

Contact us

Tel: +86-755-8981 8866 Fax: +86-755-8427 6832
Email & Skype: info@chipsmall.com Web: www.chipsmall.com
Address: A1208, Overseas Decoration Building, #122 Zhenhua RD., Futian, Shenzhen, China

iy [0



MICROCHIP

MCP73830L 2x2 TDFN
Li-Ion Battery Charger

Evaluation Board
User’s Guide

© 2011 Microchip Technology Inc. DS51992A



Note the following details of the code protection feature on Microchip devices:

. Microchip products meet the specification contained in their particular Microchip Data Sheet.

. Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the

intended manner and under normal conditions.

. There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our
knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data
Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

. Microchip is willing to work with the customer who is concerned about the integrity of their code.

. Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not

mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our
products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts
allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device
applications and the like is provided only for your convenience
and may be superseded by updates. It is your responsibility to
ensure that your application meets with your specifications.
MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR
IMPLIED, WRITTEN OR ORAL, STATUTORY OR
OTHERWISE, RELATED TO THE INFORMATION,
INCLUDING BUT NOT LIMITED TO ITS CONDITION,
QUALITY, PERFORMANCE, MERCHANTABILITY OR
FITNESS FOR PURPOSE. Microchip disclaims all liability
arising from this information and its use. Use of Microchip
devices in life support and/or safety applications is entirely at
the buyer’s risk, and the buyer agrees to defend, indemnify and
hold harmless Microchip from any and all damages, claims,
suits, or expenses resulting from such use. No licenses are
conveyed, implicitly or otherwise, under any Microchip
intellectual property rights.

QUALITY MANAGEMENT SYSTEM
CERTIFIED BY DNV

= 1SO/TS 16949:2009 =

Trademarks

The Microchip name and logo, the Microchip logo, dsPIC,
KeeLoq, KEeLoa logo, MPLAB, PIC, PICmicro, PICSTART,
PIC®2 logo, rfPIC and UNI/O are registered trademarks of
Microchip Technology Incorporated in the U.S.A. and other
countries.

FilterLab, Hampshire, HI-TECH C, Linear Active Thermistor,
MXDEV, MXLAB, SEEVAL and The Embedded Control
Solutions Company are registered trademarks of Microchip
Technology Incorporated in the U.S.A.

Analog-for-the-Digital Age, Application Maestro, chipKIT,
chipKIT logo, CodeGuard, dsPICDEM, dsPICDEM.net,
dsPICworks, dsSPEAK, ECAN, ECONOMONITOR,
FanSense, HI-TIDE, In-Circuit Serial Programming, ICSP,
Mindi, MiWi, MPASM, MPLAB Certified logo, MPLIB,
MPLINK, mTouch, Omniscient Code Generation, PICC,
PICC-18, PICDEM, PICDEM.net, PICkit, PICtail, REAL ICE,
rfLAB, Select Mode, Total Endurance, TSHARC,
UniWinDriver, WiperLock and ZENA are trademarks of
Microchip Technology Incorporated in the U.S.A. and other
countries.

SQTP is a service mark of Microchip Technology Incorporated
in the U.S.A.

All other trademarks mentioned herein are property of their
respective companies.

© 2011, Microchip Technology Incorporated, Printed in the
U.S.A,, All Rights Reserved.

‘::) Printed on recycled paper.

ISBN: 978-1-61341-454-5

Microchip received ISO/TS-16949:2009 certification for its worldwide
headquarters, design and wafer fabrication facilities in Chandler and
Tempe, Arizona; Gresham, Oregon and design centers in California
and India. The Company’s quality system processes and procedures
are for its PIC® MCUs and dsPIC® DSCs, KEELOQ® code hopping
devices, Serial EEPROMSs, microperipherals, nonvolatile memory and
analog products. In addition, Microchip’s quality system for the design
and manufacture of development systems is ISO 9001:2000 certified.

DS51992A-page 2

© 2011 Microchip Technology Inc.



MCP73830L 2X2 TDFN LI-ION BATTERY
CHARGER EVALUATION BOARD
MICROCHIP USER’S GUIDE

Table of Contents
=1 = T = 5
] (0T [0 T3 11 o 5
DOCUMENT LAYOUL ... e 5
Conventions Used in this GUIAE ........cccuuviiiiirieeiccieee e 6
Recommended Reading.........oeii i 7
The MICroChip WED SIE ....coviiiiiieeee e 7
CUSIOMET SUPPOIT ...ttt e s e 7
Document Revision HISTOMY .......ocueuiiiiiiie e 7
Chapter 1. Product Overview
1.1 INtrOAUCHION ... e 9
1.2 What is the MCP73830L 2x2 TDFN Li-lon Battery Charger
Evaluation Board? ..o e 10
1.3 What the MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board
0 o] 10T o PP ESRPR 10
Chapter 1. Installation and Operation
8 0 I 1o (o o (3T o o SRR 11
1. 2 FRAIUIES oo e 11
1.3 Getting STarted .......oooi i 12
Appendix A. Schematic and Layouts
AT INTrOUCHION . 13
A.2 Board — SChematiC ....ccooiiiieeee e 14
A.3 B0Ard — TOP LAYEI ..eeeiiiiiieiiiieiee et 15
A.4 BOArd — TOP COPPEI  .ueeeiiiiiieieee ettt ee e e 15
A.5 Board — BottOm COPPET ...eeiuiiiiieiiieie et 16
Appendix B. Bill of Materials
Worldwide Sales and ServiCe ..o nses 18

© 2011 Microchip Technology Inc. DS51992A-page 3



MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board User’s Guide

DS51992A-page 4 © 2011 Microchip Technology Inc.



®

MCP73830L 2X2 TDFN LI-ION BATTERY
CHARGER EVALUATION BOARD

MICROCHIP USER’S GUIDE

Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page humber. The numbering convention for the DS number is
“DSXXXXXA”, where “XXXXX” is the document humber and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available on line help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board. ltems discussed in
this chapter include:

» Document Layout

» Conventions Used in this Guide

* Recommended Reading

» The Microchip Web Site

» Customer Support

» Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP73830L 2x2 TDFN Li-lon Battery
Charger Evaluation Board. The manual layout is as follows:

» Chapter 1. “Product Overview” — Important information about the MCP73830L
2x2 TDFN Li-lon Battery Charger Evaluation Board.

» Chapter 1. “Installation and Operation” — Includes instructions on how to get
started with MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board and
a description of the user’s guide.

+ Appendix A. “Schematic and Layouts” — Shows the schematic and layout
diagrams for the MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board.

+ Appendix B. “Bill of Materials” — Lists the parts used to build the MCP73830L
2x2 TDFN Li-lon Battery Charger Evaluation Board.

© 2011 Microchip Technology Inc. DS51992A-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:
DOCUMENTATION CONVENTIONS

Description

| Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

Initial caps A window the Output window
A dialog the Settings dialog
A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”
dialog
Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris the radix and nis a
digit.

4'b0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants O0xXFF, ‘A’

Italic Courier New

A variable argument

file.o,where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file

[options]

Curly brackets and pipe
character: { | }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]|1}

Ellipses...

Replaces repeated text

var_name [,
var_name...]

Represents code supplied by
user

void main (void)
{
}

DS51992A-page 6
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Preface

RECOMMENDED READING

This user's guide describes how to use MCP73830L 2x2 TDFN Li-lon Battery Charger
Evaluation Board. Other useful documents are listed below. The following Microchip
documents are available and recommended as supplemental reference resources.

« MCP73830L Data Sheet - “Single-Cell Li-lon/Li-Polymer Battery Charge
Management Controllers in 2x2 TDFN” (DS25049)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

+ Distributor or Representative

* Local Sales Office

+ Field Application Engineer (FAE)
+ Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com.

DOCUMENT REVISION HISTORY
Revision A (August 2011)

« Initial Release of this Document.

© 2011 Microchip Technology Inc. DS51992A-page 7
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\ MCP73830L 2X2 TDFN LI-ION BATTERY
CHARGER EVALUATION BOARD

MICROCHIP USER'’S GUIDE
Chapter 1. Product Overview

1.1 INTRODUCTION

The MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board demonstrates the
features and abilities of Microchip’s MCP73830L Single-Chip Linear Li-lon Battery
Charger. The MCP73830L is a stand-alone, highly integrated linear battery charge
management controller that employs a constant current / constant voltage (CCCV)
charge algorithm with selectable preconditioning and charge termination. The charge
algorithm is provided for Li-lon / Li-Polymer battery packs to achieve optimal capacity
in the shortest charging time possible.

The MCP73830L uses an external resistor (Rprpg) to set the magnitude of the charge
current up to a maximum of 200 mA.

This chapter covers the following topics:

» “What is the MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board?”
* “What the MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board Kit

Includes.”
GND PROG
1 6
STAT EN
2 5
T vear VIN
3 4
Single Cell GND
Li-lon Battery N —
— W —— 7‘ —— 1yF
E— m - —_
FIGURE 1-1: MCP73830L Typical Application Circuit.
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1.2 WHAT IS THE MCP73830L 2X2 TDFN LI-ION BATTERY CHARGER
EVALUATION BOARD?

The MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board demonstrates the
use of Single-Chip Linear Li-lon Battery Charger with programmable charge current.

The MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board is set up to
evaluate single-cell Li-lon battery charge management. This board utilizes Microchip's
MCP73830L that effectively charges Li-lon batteries with high-accuracy, preset-voltage
regulation. The MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board
comes with a pre-installed 2 mm x 2 mm TDFN-6 MCP73830L. This circuit is ready to
charge Li-lon batteries at a maximum charge current rate up to 200 mA.

A built-in LED is used to display the charge status (STAT).

The MCP73830L has an internal safety timer and will terminate the charge cycle when
the timer has expired.

The MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board is designed to
observe the performance and features on the circuits via multiple test points. Users can
also discover the compact size of the layout in addition to the device itself. The circuit
can also be implemented into suitable applications without additional work.

1.3 WHAT THE MCP73830L 2X2 TDFN LI-ION BATTERY CHARGER
EVALUATION BOARD KIT INCLUDES

This MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board kit includes:
« MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board, 102-00313-R1
+ Important Information Sheet

DS51992A-page 10
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Chapter 1. Installation and Operation

1.1 INTRODUCTION

The MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board demonstrates
Microchip's stand-alone Linear Li-lon Battery Charger in a simple and compact design.

The MCP73830L requires only a minimum number of components to implement a
complete battery charge management circuit.

The MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board comes with a
6-pin TDFN MCP73830L pre-installed.

Typical applications for MCP73830L are MP3 players, USB-powered systems,
handheld medical instruments, Bluetooth headsets and portable devices.

1.2 FEATURES

The MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board has the following
features:

+ 2x2 TDFN-6 Package Size

» Programmable charge current between 20 mA to 200 mA
» A status LED to indicate charge status

» EN pin to enable/disable charger

» A preset internal safety timer

» Built-in Under Voltage Current Limit Control

© 2011 Microchip Technology Inc. DS51992A-page 11
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1.3 GETTING STARTED

The MCP73830L 2x2 TDFN Li-lon Battery Charger Evaluation Board is fully assembled
and tested for charging a single-cell Li-lon or Li-Polymer battery with an input supply of
3.75V to 6V.

1.3.1 Power Input and Output Connection

1.3.1.1  POWERING THE MCP73830L 2X2 TDFN LI-ION BATTERY CHARGER
EVALUATION BOARD

1. Connect the positive battery terminal to Vgat and negative battery terminal to
GND.

2. Connect the DC power supply Negative terminal to GND.

Connect the 5V DC power supply Positive terminal to V.

4. It should initiate the battery charging cycle when the power source is present.

w

Note: The battery voltage needs to be below 4.05V (typical) in order to initiate a
new charging cycle.

5. Charging current should be able to read off the multi-meter that is in series with
battery.

Note: The battery can be replaced with test circuit or electronic load that can sync
current with the DC power supply.

o

Pulling EN pin high disables charging activities.

Fast Charge Current can be programmed with various resistors that are based
on Figure 1-1.

~

200
180
160
140
120
100
80
60
40
20
0

Charge Current (mA)

1 3 5 7 9 11 13 15

Programming Resistor (kQ)

FIGURE 1-1:  Resistor vs. Charge Current.

DS51992A-page 12 © 2011 Microchip Technology Inc.
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Appendix A. Schematic and Layouts

A.1  INTRODUCTION
This appendix contains the following schematics and layouts for the MCP73830L 2x2
TDFN Li-lon Battery Charger Evaluation Board:
+ Board — Schematic
» Board — Top Layer
» Board — Top Copper Layer
» Board — Bottom Copper Layer

© 2011 Microchip Technology Inc. DS51992A-page 13
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Schematic and Layouts
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Appendix B. Bill of Materials

TABLE B-1:  BILL OF MATERIALS (BOM)

Qty | Reference Description Manufacturer Part Number

1 - Printed circuit board Microchip Technology Inc. | 102-00313

2 C1,Cc2 CAP CER 1.0uF 10V 10% X5R 0805 Panasonic® - ECG GRM219R61A105KC01D
1 D1 LED ALINGAP RED CLEAR 0805 SMD | Panasonic - ECG 598-8110-107F

1 R1 RES 510 OHM 1/8W 1% 0805 SMD Panasonic - ECG ERJ-6ENF5100V

1 R2 RES 2.00K OHM 1/8W 1% 0805 SMD Panasonic - ECG ERJ-6ENF2001V

1 U1 Single-Chip Linear Li-lon Battery Charger | Microchip Technology Inc. | MCP73830L

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The
released BOM used in manufacturing uses all RoHS-compliant components.

© 2011 Microchip Technology Inc. DS51992A-page 17



MICROCHIP

Worldwide Sales and Service

AMERICAS
Corporate Office

2355 West Chandler Blvd.
Chandler, AZ 85224-6199
Tel: 480-792-7200

Fax: 480-792-7277
Technical Support:
http://www.microchip.com/
support

Web Address:
www.microchip.com

Atlanta

Duluth, GA

Tel: 678-957-9614
Fax: 678-957-1455

Boston
Westborough, MA
Tel: 774-760-0087
Fax: 774-760-0088
Chicago

Itasca, IL

Tel: 630-285-0071
Fax: 630-285-0075

Cleveland
Independence, OH
Tel: 216-447-0464
Fax: 216-447-0643
Dallas

Addison, TX

Tel: 972-818-7423
Fax: 972-818-2924

Detroit

Farmington Hills, Ml
Tel: 248-538-2250
Fax: 248-538-2260

Indianapolis
Noblesville, IN

Tel: 317-773-8323
Fax: 317-773-5453

Los Angeles
Mission Viejo, CA
Tel: 949-462-9523
Fax: 949-462-9608

Santa Clara

Santa Clara, CA
Tel: 408-961-6444
Fax: 408-961-6445

Toronto
Mississauga, Ontario,
Canada

Tel: 905-673-0699
Fax: 905-673-6509

ASIA/PACIFIC

Asia Pacific Office
Suites 3707-14, 37th Floor
Tower 6, The Gateway
Harbour City, Kowloon
Hong Kong

Tel: 852-2401-1200
Fax: 852-2401-3431
Australia - Sydney
Tel: 61-2-9868-6733
Fax: 61-2-9868-6755
China - Beijing

Tel: 86-10-8569-7000
Fax: 86-10-8528-2104

China - Chengdu
Tel: 86-28-8665-5511
Fax: 86-28-8665-7889

China - Chongqing
Tel: 86-23-8980-9588
Fax: 86-23-8980-9500

China - Hangzhou
Tel: 86-571-2819-3187
Fax: 86-571-2819-3189

China - Hong Kong SAR
Tel: 852-2401-1200

Fax: 852-2401-3431
China - Nanjing

Tel: 86-25-8473-2460
Fax: 86-25-8473-2470

China - Qingdao
Tel: 86-532-8502-7355
Fax: 86-532-8502-7205

China - Shanghai
Tel: 86-21-5407-5533
Fax: 86-21-5407-5066

China - Shenyang
Tel: 86-24-2334-2829
Fax: 86-24-2334-2393

China - Shenzhen
Tel: 86-755-8203-2660
Fax: 86-755-8203-1760

China - Wuhan

Tel: 86-27-5980-5300

Fax: 86-27-5980-5118
China - Xian

Tel: 86-29-8833-7252

Fax: 86-29-8833-7256

China - Xiamen
Tel: 86-592-2388138
Fax: 86-592-2388130

China - Zhuhai
Tel: 86-756-3210040
Fax: 86-756-3210049

ASIA/PACIFIC

India - Bangalore
Tel: 91-80-3090-4444
Fax: 91-80-3090-4123

India - New Delhi
Tel: 91-11-4160-8631
Fax: 91-11-4160-8632

India - Pune
Tel: 91-20-2566-1512
Fax: 91-20-2566-1513

Japan - Yokohama
Tel: 81-45-471- 6166
Fax: 81-45-471-6122

Korea - Daegu
Tel: 82-53-744-4301
Fax: 82-53-744-4302

Korea - Seoul

Tel: 82-2-554-7200
Fax: 82-2-558-5932 or
82-2-558-5934

Malaysia - Kuala Lumpur
Tel: 60-3-6201-9857
Fax: 60-3-6201-9859

Malaysia - Penang
Tel: 60-4-227-8870
Fax: 60-4-227-4068

Philippines - Manila
Tel: 63-2-634-9065
Fax: 63-2-634-9069
Singapore

Tel: 65-6334-8870
Fax: 65-6334-8850

Taiwan - Hsin Chu
Tel: 886-3-5778-366
Fax: 886-3-5770-955

Taiwan - Kaohsiung
Tel: 886-7-536-4818
Fax: 886-7-330-9305
Taiwan - Taipei

Tel: 886-2-2500-6610
Fax: 886-2-2508-0102

Thailand - Bangkok
Tel: 66-2-694-1351
Fax: 66-2-694-1350

EUROPE

Austria - Wels

Tel: 43-7242-2244-39
Fax: 43-7242-2244-393
Denmark - Copenhagen
Tel: 45-4450-2828

Fax: 45-4485-2829

France - Paris

Tel: 33-1-69-53-63-20
Fax: 33-1-69-30-90-79
Germany - Munich
Tel: 49-89-627-144-0
Fax: 49-89-627-144-44
Italy - Milan

Tel: 39-0331-742611
Fax: 39-0331-466781

Netherlands - Drunen
Tel: 31-416-690399
Fax: 31-416-690340
Spain - Madrid

Tel: 34-91-708-08-90
Fax: 34-91-708-08-91
UK - Wokingham

Tel: 44-118-921-5869
Fax: 44-118-921-5820

08/02/11

DS51992A-page 18

© 2011 Microchip Technology Inc.



	Contact us
	Trademarks
	Table of Contents
	Preface
	Introduction
	Document Layout
	Conventions Used in this Guide
	Recommended Reading
	The Microchip Web Site
	Customer Support
	Document Revision History

	Chapter 1. Product Overview
	1.1 Introduction
	1.2 What is the MCP73830L 2x2 TDFN Li-Ion Battery Charger Evaluation Board?
	1.3 What the MCP73830L 2x2 TDFN Li-Ion Battery Charger Evaluation Board kit includes

	Chapter 1. Installation and Operation
	1.1 Introduction
	1.2 Features
	1.3 Getting Started

	Appendix A. Schematic and Layouts
	A.1 Introduction
	A.2 Board – Schematic
	A.3 Board – Top Layer
	A.4 Board – Top Copper
	A.5 Board – Bottom Copper

	Appendix B. Bill of Materials
	Worldwide Sales and Service

